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Chapter 1 Overview

1.1 Product Introduction

The SBC8018 evaluation board is a compact, low-cost with high-performance evaluation board
based on Texas instruments (Tl) AM1808 microprocessor. AM1808 is an integration of 375 MHz
ARM9 low-power application processor with 128K-Byte On-the chip memory, and provided lots of
peripheral interface. SBC8018 board expands the hardware capabilities including LAN port, audio
input/output interface, USB OTG, USB HOST, SATA interface, TF slot, serial port, JTAG interface,
camera interface, TFT LCD interface, touch screen interface and keyboard interface.

SBC8018 board can be used for the following applications:

Intelligent instrument

® Service point

® Educational plant

® Portable data terminal

® Placeholder intelligent sensor
® A formal data terminal

® Industrial Control

® Home Automation
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Figure 1-1 SBC8018 Evaluation Board Functional Block Diagram

1.2 Features

SBC8018 evaluation board is based on AM1808 processor and is one compact board which
integrates all functions and features of TI's AM1808 ARM9 processor. Some of the board features
are mentioned below:
Mechanical Parameters

® Working temperature: 0°C ~ 70°C

® Humidity Range: 20% ~ 90%, non-condensable

® Dimensions: 112.24mm x 82.29mm

® Power Consumption: 5SV@0.22A (working without LCD)

® Power Input: +5V/2A
Processor

® 375-MHz ARM926EJ-S™ RISC Core

® ARM926EJ-S Core
Memory

® 128MB NAND Flash
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® 128MB Mobile DDR

Audio/Video Interfaces
® An audio Microphone input interface (3.5mm audio jack, red)
® Atwo-channel audio line output interface (3.5mm audio jack, green)
® ATFT-LCD interface (24 bit color, 1.8 V logic, with touch screen)
Data Transfer Interface
® Serial port:
B UARTL, 3 line serial port, TTL based voltage
B UARTZ2, 3 line serial port, TTL based voltage
B UARTS, 5 line serial port, RS232 based voltage
® 1xUSB 2.0OTG interface (OTG connector)
® 1 xUSBL1.1 Interface (Type A)
® 10/100Mbps Ethernet Interface (RJ45 jack)
® 1 channel TF card slot
® 1 channel SATA interface (supports both SATA | (1.5 Gbps) and SATA Il (3.0 Gbps))
® 1 channel 14-pin JTAG interface
® Multi-functional expand interface(lIC, SPI, MCBSP, UART, 1.8V, 3.3V, 5V, GPIO, EMA)
Input Interface
® 2 x Camera interfaces (8 bit, 1.8 V logic)
® 4 buttons (RESET,BACK,HOME,MENU)
LED
® 1 PowerLED

® 3 User LEDs
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Chapter 2 Hardware System

2.1 CPU

2.1.1 CPU Introduction

The AM1808 microprocessor contains an ARM RISC CPU for general-purpose processing and
systems control. The AM1808 ARM microprocessor consists of the following primary components:
® ARM926EJ-S RISC processor core and associated memories
® A setof I/O peripherals

® A powerful DMA subsystem and SDRAM EMIF interface

2.1.2 CPU Features

Clock

The OSCIN/ OSCOUT system input clock (24 MHz) is used to generate the main source clock for
the device. It also provides the DPLLs to several CPU other modules.

Reset

The function of reset is determined by the input signal on RESETN pin of the CPU, Reset is

enabled when LOW level signal (high to low) is given.
ARM Subsystem

The ARM Subsystem includes the following features:
® ARM926EJ-S RISC processor
® ARMV5TEJ (32/16-bit) instruction set
® Little endian
® System Control Co-Processor 15 (CP15)
® MMU
® 16KB Instruction cache
® 16KB Data cache
® \Write Buffer
® Embedded Trace Module and Embedded Trace Buffer (ETM/ETB)

® ARM Interrupt controller
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ARMO926EJ-S RISC CPU

The ARM Subsystem integrates the ARM926EJ-S processor. The ARM926EJ-S processor is a
member of ARM9 family of general-purpose microprocessors. This processor is targeted at
multi-tasking applications where full memory management, high performance, low die size, and
low power are all important. The ARM926EJ-S processor supports the 32-bit ARM and 16 bit
THUMB instruction sets, enabling the user to trade off between high performance and high code
density. Specifically, the ARM926EJ-S processor supports the ARMV5TEJ instruction set, which
includes features for efficient execution of Java byte codes, providing Java performance similar to

Just in Time (JIT) Java interpreter, but without associated code overhead.

The ARM926EJ-S processor supports the ARM debug architecture and includes logic to assist in
both hardware and software debug. The ARM926EJ-S processor has a Harvard architecture and
provides a complete high performance subsystem, including:

® ARM926EJ -S integer core

® CP15 system control coprocessor

® Memory Management Unit (MMU)

® Separate instruction and data caches

® \Write buffer

® Separate instruction and data (internal RAM) interfaces

® Separate instruction and data AHB bus interfaces

® Embedded Trace Module and Embedded Trace Buffer (ETM/ETB)

ARM Internal Memory
® 8 KBRAM
® 64 KB built-in ROM

® Embedded Trace Module and Embedded Trace Buffer (ETM/ETB)
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Figure 2-1 ARM Subsystem
2.2 Introduction to the Expanded Chip:

2.2.1 TPS65070

The TPS6507x are single chip Power Management IC, the charger can either be supplied by a
USB port on pin USB or by a DC voltage from a wall adapter connected to pin. Three highly
efficient 2.25MHz step-down converters are targeted at providing the core voltage, memory and
I/O voltage in a processor based system. The step-down converters allow the use of small

inductors and capacitors to achieve a small solution size.

The TPS6507x also integrate two general purpose LDOs for an output current of 200mA. These
LDOs can be used to power a TF-card interface and an always-on rail, but can be used for other
purposes as well. Each LDO operates with an input voltage range between 1.8V and 6.3V allowing

them to be supplied from one of the step-down converters or directly from the main battery.

2.2.2 K9F1G08UO0B

The K9F1GO0O8UOB is the 128MB NAND flash memory chips used in SBC8018 evaluation board.
This NAND Flash chip is directly interfaced to the CPU for faster memory access and read/write

cycles.
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2.2.3 HSMS1G62MFP

The H5SMS1G62MFP-K3M is the 128MB DDR memory chip used in SBC8018 evaluation board,

This DDR RAM is connected directly the CPU DDR/SDRAM interface for faster memory access.

2.2.4 DM9161

The DM9161 is a fully integrated and cost-effective low pin count single chip Fast Ethernet
controller with a general processor interface, a 10/100M PHY and 4K DWORD SRAM. It is
designed with low power and high performance process that support 3.3V with 5V I/O tolerance.

SBC8018 uses 10/100M adaptive network interface of DM9161, in which, the 10/100M Ethernet
module is compatible to IEEE 802.3 standard protocol. The cable interface used is a standard

RJ45 cable, with a connection indicator and a transmission indicator.

2.2.5 TLV320AIC33IRGZR

The TLV320AIC33IRGZR is a low-power stereo audio codec with stereo headphone amplifier, as
well as ten audio inputs and seven audio outputs programmable in single-ended or fully differential
configurations. Extensive register enabling the stereo 48 kHz DAC playback as low as 15 mw from
a 3.3V analog supply, making it ideal for portable battery-powered audio and telephony

applications.

The playback path includes mix/mux capability from the stereo DAC and selected inputs, through
programmable volume controls, to the various outputs. TLV320AIC33IRGZR has Ten Audio Input

Pins and Seven Audio Output Drivers.

2.2.6 MAX3232

The function of MAX3232 is mainly to convert TTL logic level signal to RS232 logic level, which
helps the board at TTL logic to interface with PC working at RS232 logic level. The SBC8018

evaluation board uses UART?2 as debugger serial port; the default voltage for this UART2 is 1.8V,

Copyright © 2011 by element14 User Manual
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it is necessary to convert this voltage from 1.8V to 3.3V in order to connect the board to the eternal

world.

2.3 Hardware Interface

The following section provides you the detailed information on the peripherals, with the pin

description, and its functionality available on SBC8018 evaluation board.

3wl

40

i

134

36

#

M1

ik

M

Figure 2-2 Hardware Interface chart

2.3.1 Power Input Jack

Table 2-1 power input interface

J40
Pin Signal Function
1 GND GND
2 NC NC
3 +5V Power supply (+5V) 2A (Type)
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2.3.2 Power Output Interface

Table 2-2 power output interface

J18
Pin Signal Function
1 +5V 5V output
2 GND GND

2.3.3 Power Switch

Table 2-3 power switch

SW1
Pin Signal Function
1 DC IN VDD Input
2 +5VDC_IN +5V
3 NC NC

2.3.4 TFT_LCD Interface

Table 2-4 TFT_LCD interface

J1

Pin Signal Function

1 B_NUO Test Point

2 B_NU1 Test Point

3 B_NU2 Test Point

4 LCD_DO LCD data bit0
5 LCD_D1 LCD data bitl
6 LCD D2 LCD data bit2
7 LCD_D3 LCD data bit3
8 LCD_D4 LCD data bit4
9 GND GND

Copyright © 2011 by element14
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10 G_NUO Test Point

11 G_Nu1l Test Point

12 LCD_D5 LCD data bit5

13 LCD_D6 LCD data bit6

14 LCD_D7 LCD data bhit7

15 LCD_D8 LCD data bit8

16 LCD_D9 LCD data bit9

17 LCD_D10 LCD data bit10

18 GND GND

19 R_NUO Test Point

20 R_NuU1 Test Point

21 R_NU2 Test Point

22 LCD_D11 LCD data bit11l

23 LCD_D12 LCD data bit12

24 LCD_D13 LCD data bit13

25 LCD_D14 LCD data bit14

26 LCD_D15 LCD data bit15

27 GND GND

28 R_LCD_DEN LCD AC bias enable chip select

29 R_LCD_HSYNC LCD vertical sync

30 R_LCD_VSYNC LCD horizontal sync

31 GND GND

32 R _LCD_DCLK LCD Pixel Clock

33 GND GND

34 TOUCH_X1 Input 1 to the x-plate for the touch screen
35 TOUCH_X2 Input 2 to the x-plate for the touch screen
36 TOUCH_Y1 Input 1 to the y-plate for the touch screen
37 TOUCH_Y2 Input 2 to the y-plate for the touch screen
38 R_LCD_SPICLK | SPI clock

39 R_LCD_MOSI Slave data in, master data out

Copyright © 2011 by element14
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40 R_LCD_MISO Slave data out, master data in
41 R_LCD_SPICS SPI enable

42 lIC_CLK IIC master serial clock, NC
43 [IC_DAT lIC serial bidirectional data, NC
44 GND GND

45 +1P8V_LDO +1.8V

46 +3P3V +3.3V

47 +5VDC_IN +5V

48 +5VDC_IN +5V

49 RESET +1.8V

50 R_LCD_PWREN Power on enable

2.3.5 AUDIO OUTPUT Jack

Table 2-5 Audio out interface

J38
Pin Signal Function
1 GND GND
2 LINE_OUT_LP Left output
3 LINE_OUT_RP Right output
4 LINE_OUT_RP Right output
5 LINE_OUT_LP Left output

Copyright © 2011 by element14 User Manual
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2.3.6 Camera Interface

Table 2-6 camera interface

J35,J43
Pin Signal Function
1 GND GND
2 DO Test Point
3 D1 Test Point
4 R_CAM_DO VPIF capture data bit O
5 R _CAM D1 VPIF capture data bit 1
6 R_CAM_D2 VPIF capture data bit 2
7 R_CAM_D3 VPIF capture data bit 3
8 R_CAM_D4 VPIF capture data bit 4
9 R_CAM_D5 VPIF capture data bit 5
10 R_CAM_D6 VPIF capture data bit 6
11 R_CAM_D7 VPIF capture data bit 7
12 D10 Test Point
13 D11 Test Point
14 GND GND
15 PCLK Pixel clock
16 GND GND
17 CAM_HS_A0 Horizontal synchronization
18 +5VDC_IN 5V
19 CAM_VS A0 Vertical synchronization
20 +3P3V 3.3V
21 CAM_XCLKA_AO0 | Test Point
22 CAM_XCLKB_AO0 Test Point
23 GND GND
24 CAM_FLD_AO Test Point
25 uP_CAM_WENO Test Point
26 uP_CAM_STR Test Point
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27 CAM_SDA I2CO0 serial data
28 CAM_SCL I2CO0 serial clock
29 GND GND
30 +1P8V_LDO 1.8V

2.3.7 MIC IN Jack

Table 2-7 MIC IN interface

J39
Pin Signal Function
1 GND GND
2 LINE_IN_LP Left input
3 LINE_IN_RP Right input
4 LINE_IN_RP Right input
5 LINE_IN_LP Left input

2.3.8 Serial Ports

Table 2-8 serial port

J9
Pin Signal Function
1 NC NC
2 RSA_RXD Receive data
3 RSA_TXD Transit data
4 NC NC
5 GND GND
6 NC NC
7 RSA _RTS Request To Send
8 RSA _CTS Clear To Send
9 NC NC
10 GND GND
11 GND GND
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2.3.9 LAN Interface

Table 2-9 LAN interface

J58
Pin Signal Function
1 LAN_TX+ TX+ output
2 LAN_TX- TX- output
Link to analog transmit power input with
3 CT
OR resistance
4 48&5 Transformer
5 7&8 Transformer
Link to analog transmit power input with
6 CT
OR resistance
7 LAN_RX+ RX+ input
8 LAN_RX- RX- input
9 YEL Link LED
10 VDD 3.3V Power for LED
11 GRN Speed LED
12 VDD 3.3V Power for LED
13 CHGND GND
14 CHGND GND
15 NC NC
16 NC NC

2.3.10 SATA Interface

Table 2-10 SATA interface

J32
Pin Signal Function
1 GND GND
2 SATA TXP SATA receive data(positive)
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3 SATA TXN SATA receive data(negative)
4 GND GND

5 SATA_RXN SATA transmit data(negative)
6 SATA_RXP SATA transmit data(positive)
7 GND GND

8 NC NC

9 GND GND

2.3.11 USB OTG Interface

Table 2-11 USB OTG interface

J34
Pin Signal Function
1 USBO_VBUS +5V
2 USBO_D- USB Data-
3 USBO_D+ USB Data+
4 ID USB ID
5 GND GND
6 G2 GND
7 G3 GND
8 G4 GND
9 G5 GND
10 G6 GND
11 NC NC
12 NC NC
Copyright © 2011 by element14 User Manual
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2.3.12 USB HOST Interface

Table 2-12 USB HOST interface

J33
Pin Signal Function
1 USB1 VBUS +5V
2 USB1_D- USB Data-
3 USB1 D+ USB Data+
4 GND GND
5 CHGND GND
6 CHGND GND

2.3.13 TF Card Interface

Table 2-13 TF interface

J36
Pin Signal Function
1 DAT2 Card data 2
2 DAT3 Card data 3
3 CMD Command Signal
4 VDD VDD
5 CLK Clock
6 VSS GND
7 DATO Card data O
8 DAT1 Card data 1
9 CD Card detect
10 PGND GND
11 PGND GND
12 PGND GND
13 PGND GND
14 NC NC
15 NC NC
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2.3.14 JTAG Interface

Table 2-14 JTAG interface

J37
Pin Signal Function
1 TMS Test mode select
2 NTRST Test system reset
3 TDI Test data input
4 GND GND
5 VIO 1.8V
6 NC NC
7 TDO Test data output
8 GND GND
9 RTCK Receive test clock
10 GND GND
11 TCK Test clock
12 GND GND
13 EMUO Test emulation 0
14 EMU1 Test emulation 1

2.3.15 Expansion Interface

Table 2-15 expansion interface

J41
Pin Signal Function
1 GND GND
2 GND GND
3 EMA_A_16_EXP GPIO
4 EMA D 15 EXP GPIO
5 EMA_A 15 EXP GPIO
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6 EMA D 14 EXP GPIO
7 EMA_A 14 EXP GPIO
8 EMA_D_13 EXP GPIO
9 EMA_A 13 EXP GPIO
10 EMA_D_12 EXP GPIO
11 EMA_A_0_EXP GPIO
12 EMA_D_11 EXP GPIO
13 EMA_BA 1 EXP GPIO
14 EMA_D_10_EXP GPIO
15 EPWMN1_TZ0 GPIO
16 EMA_D_9 EXP GPIO
17 ECAP2_APWM2 GPIO
18 EMA_D_8 EXP GPIO
19 AIC_WCLK GPIO
20 EMA_CLK_EXP GPIO
21 AFSR GPIO
22 EMA_SDCKE_EXP | GPIO
23 AIC_MCLK GPIO
24 EMA_CSn_5 EXP | GPIO
25 GND GND
26 EMA_CSn_4 EXP | GPIO
27 AIC_BCLK GPIO
28 EMA_CSn_2 EXP | GPIO
29 ACLKR GPIO
30 EMA_CSn_0_EXP | GPIO
31 GND GND
32 EMA_WAIT_1 EXP | GPIO
33 GND GND
34 GND GND
35 +5VDC_IN +5V
36 GND GND
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37 +3P3V 3.3V
38 +1P8V_LDO 1.8V
39 GND GND
40 GND GND
Table 2-16 expansion interface

J42
Pin Signal Function
1 GND GND
2 GND GND
3 uP_SPI1_CLK SPI1 clock
4 uP_McBSP1 CLKR_EXP | McBSPL1 receive clock
5 uP_SPI1_SOMI SPI1 data slave-out-master-in
6 uP_McBSP1_CLKX_EXP | McBSP1 transmit clock
7 uP_SPI1_SIMO SPI1 data slave-in-master-out
g UP MCBSPO CLKS EXP McBSP1 sample rate generator

- - - clock input

9 uP_SPI1_SCSn0 SPI1 chip selects
10 AIC_DOUT McBSPL1 receive frame sync
11 uP_SPI1_ENAN SPI1 enable
12 AIC_DIN McBSP1 transmit frame sync
13 GND GND
14 uP_McBSPO_DR_EXP McBSP1 receive data
15 UART1_RXD UART1 receive data
16 uP_McBSPO_DX_EXP McBSP1 transmit data
17 UART1_TXD UARTL1 transmit data
18 GND GND
19 UART1_RTSn UART1 ready-to-send output
20 UART2_RXD UART2 receive data
21 AIC_MCL UART1 clear-to-send input
22 UART2_TXD UART2 transmit data
23 GND GND
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24 12C0_SCL I12CO0 serial clock

25 GND GND

26 [2C0_SDA 12CO0 serial data

27 GND GND

28 GND GND

29 GND GND

30 uP_SPI0O_CLK SPIO clock

31 GDN GND

32 uP_SPI0O_SOMI SPI0 data slave-out-master-in
33 GND GND

34 uP_SPIO_SIMO SPIO0 data slave-in-master-out
35 GND GND

36 uP_SPIO_SCSn0 SPIO chip selects

37 +5VDC_IN +5V

38 uP_SPI0_ENAN 1.8V

39 +3P3V +3.3V

40 +1P8V_LDO +1.8V

2.3.16 DIP Switch

Table 2-17 DIP Switch

S7
Pin Function
1 PWR_BOOT Link to PWR_BOOT with 1K resistor
2 GND Link to GND with 1K resistor
3 GND Link to GND with 1K resistor
4 PWR_BOOT Link to PWR_BOOT with 1K resistor
5 LCD_D12 LCD data bit 12
6 LCD_D11 LCD data bit 11
7 LCD D10 LCD data bit 10
8 LCD_D9 LCD data bit 9
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2.3.17 KEY Switch

Table 2-18 KEY Switch

Key
Pin Function
S6 uP_RESETN Device reset input
S8 USER_BACK GPIO
S9 USER_MENU GPIO
S10 USER_HOME GPIO

2.3.18 LEDs
Table 2-19 LED
LED

Pin Signal Function
D2 User LED 1 User Definitude
D3 User_LED 2 User Definitude
D4 User LED 3 User Definitude
D5 +3P3V 3.3V power indicator
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Chapter 3 Linux Operating System

3.1 Introduction

This section is intended to provide detailed instruction on Operating System Software
development for SBC8018 evaluation board:

1) Describes the software resources provided by SBC8018.

2) Describes the software feature.

3) Explains the software development including how to set up the development environment, the
building guidance of the boot loader, kernel and file system, and the development of device driver.
4) Provides flashing methods with U-BOOT prompts.

5) Shows the usage of SBC8018

6) Shows the application development.

In this part, it is suggested to:
1) Install Ubuntu Linux in advance, please refer to Appendix |l for details;

2) Master relative embedded Linux development technology.

3.2 Software Resources

This chapter provides an overview of software system components of SBC8018. A basic software
system consists of four parts: u-boot, kernel and rootfs. The Figure 3-2 shows the structure of the

system:

Figure 3-1

Copyright © 2011 by element14 User Manual




element 1u S

Features and functions of each part of the system are given below:

1) U-boot is a bootstrap program, it's used for interacting with users and updating images and
loading the kernel;

2) The latest 2.6.x kernel is employed here and it can be customized to use on SBC8018
evaluation board.

3) Rootfs employs Open-source system ‘jffs2”.

3.3 Board Support Package (BSP) Features

The SBC8018 Board Support Package (BSP) is used for customizing and generating the Linux
operating system applicable to SBC8018 hardware platform. Users can conduct a secondary
development on the basis of this BSP. The BSP in the CD provided with the SBC8018 evaluation
kit contains as bellows:

Table 3-1 BSP Features

ltem Note

NAND

MMC/SD
BIOS u-boot

FAT

NET

Supports ROM/CRAM/EXT2/EXT3/FAT/NFS/
Kernel Linux-2.6.x

JFFS2 and various file systems

serial Series driver

rtc Hardware clock driver

net 10/100M Ethernet card DM9000 driver

flash nand flash driver (supports nand boot)
Device

lcd TFT LCD driver
Driver

touch screen Touch screen controller ads7846 driver
Debug

tf mmc/sd controller driver

usb otg 2.0 driver (can be configured as slave
usb otg
device currently)

usb ehci usb ehci driver
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audio Audio driver
Camera driver (support CAMB8000-A camera
camera
module)
button gpio button driver
led user led lamp driver
sata 1.5-3.0G SATA driver

3.4 System Development

3.4.1 How to Setup Operating System Development Environment

Before executing software development on SBC8018, the user has to install Linux cross
development environment on its computer. How to install a cross development environment will be

explained below by taking Ubuntu operating system as an example.

3.4.1.1 Installation of Cross Compilation Tools
Installation of cross compilation tools is done by using the software CD provided along with this Kit,
to start the process insert the CD and allow it for auto run, Ubuntu will mount the disc under the
directory /media/cdrom, the cross compilation tools are saved under the directory
/media/cdrom/linux/tools.

mkdir $HOME/tools

cd /media/cdrom/linux/tools

tar -jxvf arm-2009q1-203-arm-none-linux-gnueabi-i686-pc-linux-gnu.tar.bz2 -C

$HOME/tools

3.4.1.2 Installation of Other Tools
Some of the other development tools used for source code compilation are present in the directory
linux/tools; the user can execute the following commands to copy them to the local folder:

cd /media/cdrom/linux/tools

cp mkimage $HOME/tools

cp mkfs.jffs2 $HOME/tools
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3.4.1.3 Addition of environment variables
After all above tools are installed, it is necessary to use the following commands to add them in the
temporary environment variables:

export PATH=$HOME/tools/arm-2009g1/bin:$HOME/tools:$PATH

The user can write it in the .barsrc file under the user directory, such that
the addition of environment variables will be finished automatically when
the system is booted; command echo $PATH can be used to check the

path.

3.4.2 System Compilation

3.4.2.1 Preparation
Source codes for all the components of the system are available in the disc under the directory
linux/source; users need to extract them to the Ubuntu system before starting the development:
mkdir SHOME/work
cd $HOME/work
tar xvf /media/cdrom/linux/source/uboot-03.20.00.14.tar.bz2
tar xvf /media/cdrom/linux/source/linux-03.20.00.14.tar.bz2
cp /media/cdrom/linux/source/ramdisk ./
mkdir rootfs
sudo mount -t ext2 —o loop ramdisk rootfs
After completing the above steps, the current directory will generate uboot-03.20.00.14,

linux-03.20.00.14 and rootfs directories.

3.4.2.2 X-loader Image Generation
The SBC8018 evaluation board supports UART boot or NAND boot. The image files are different

for the different boot modes, and the methods for mapping are also different.
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1) To generate image file u-boot
cd uboot-03.20.00.14
make distclean
make da850evm_config
make

After completing the above steps, the current directory will generate the required u-boot file.

Copy current u-boot file to Windows system, the AlSgen tool will launch on

Windows.

2) To generate the u-boot-uart-ais.bin for UART start-up
= Put the new u-boot file to the folder [d:\sbc8018].
= Make sure you had installed “AlSgen_d800k006 Install v1.7.exe” under the folder
[CD\linux\tools\].
= Click Windows XP -> Start -> All Programs -> Texas Instruments -> AlSgen for D800K006
-> AlSgen for D800K006 to open AlSgen tool.
a) Launches the ASlgen, click “File”-> “Load Configuration” to open AM1808-UART.cfg
from the CD under the folder CD\linux\tools\.
b) Added the u-boot file under the folder [d:\sbc8018\] to the [ARM Application File:]
c) Sets the output file path [AIS Output File] as [d:\sbc8018\u-boot-uart-ais.bin].
d) Click [Generate AIS], “u-boot-uart-ais.bin” will be generated under the folder

[d:\sbc8018].
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AISgen for DBOOK0DG M=

File Help

General |Feripheral | FLLD FLLi IR

Device Type: | dS00KIDZ v| s v
Foot Made: | UARTZ v |

Clock Source: Crystal v oz mi
Configure FLLD Configure FLLL

[ ]Configure SIEAM Configure IIR
[]Configure FSC []Configure Finmux

[] Enable CEC
ARM Application FildD:tsbead18tu-boot | (. ]
ATS Output File: |-:1:"xschDlB"mu—bnnt-uart-ais.]:-inl | (. ]
Wrote 210836 bytes to file d:\sbc8018\u-bootuart-ais.bin | Generate AIS |

Figure 3-2 ASlIgen for DBOOK006
3) To generate u-boot-nand-ais.bin for NAND Flash boot up
a) Launches the ASlgen, click “File”-> “Load Configuration” to open AM1808-NAND.cfg
under the folder CD\linux\tools\.
b) Added the u-boot file under the folder [d:\sbc8018\] to the [ARM Application File:]
c) Sets the output file path [AIS Output File] as [d:\sbc8018\u-boot-nand-ais.bin].
d) Click [Generate AIS], “u-boot-nand-ais.bin” will be generated under the folder

[d:\sbc8018].

3.4.2.3 Kernel compilation
1) Choose the Display Device
Modify the lines as below according to the display screen size in the file:
[linux-03.20.00.14/arch/arm/mach-davinci/board-da850-evm.c]
For 4.3-inch LCD:
#define LCD_4_3INCH 1
#define LCD_7INCH 0
For 7-inch LCD:

#define LCD_4_3INCH 0
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#define LCD_7INCH 1
2) Kernel compilation
cd linux-03.20.00.14
make distclean
make sbc8018_defconfig
make ulmage
After completing the above steps, the required ulmage file will be generated under the directory

arch/arm/boot.

3.4.2.4 Generation of File System
cd $HOME/work
sudo $HOME/tools/mkfs.jffs2 —r rootfs —o jffs2.img
After completing the above steps, the current directory will generate the the required “jffs2.img”

file.

3.4.3 System Customization

As Linux kernel has many configuration options, the user can increase or reduce the kernel
features by using available default kernel configurations according to their best requirements. The

general process of system customization is described with examples below;

3.4.3.1 Modification of Kernel Configuration
The source code for factory default kernel configuration is provided in the below directory:
[linux-03.20.00.14/arch/arm/configs/sbc8018_defconfig]
User can carry out system customization on this basis:
cd linux-03.20.00.14
cp arch/arm/configs/sbc8018 defconfig .config

make menuconfig
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If an error occurs in the system when make menuconfig is input, it is

necessary to install ncurse in the Ubuntu system; ncurse library is a
character graphic library, used for make menuconfig of kernel; the specific
installation instruction is:

sudo apt-get install ncurses-dev

How do perform the system customization is described below using USB gadget and USB mass
storage device as an example:

1) Select Device driver

General setup --->
[#] Fnakle loadable medule suppert ---3
[#] Fnakle the block layer ---3
System Tvpe --->
Pus support ---3>
Fernel Features ---3
Boot options ---3
CPU Power Management ---3
Floating point emdation ---3»
Userspace hinary forwats ---3>
Power management options ---3
[ #] Wetworking support ---3
Device Drivers ---
File svstems ---3
Fernel hacking ---3>
Security options ---3»
- % Cryptographic &P --->
Library routines ---3>

Load an 8] ternate Configuration File
Sawve an &l ternate Configuration File

Sel ect, < Exit > < Help >
Figure 3-3

2) Select USB support
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[ 1 ISDM support ---3
Input device support ---3>
Character devices ---3
<¥ [20 support ---3>
[#] SPI support ---3
- % GPIO Suppert ---3»
< » Dallas’s 1-wire support ---3
< » Power supply class support ---3
< » Hardware Monitoring support ---3»
< % Generic Thernal sysfs driver ---3
[ ] ¥atchdog Timer Support ---3
Sonics Silicen Backplane ---3
Mol tifinction device drivers ---3
Ml tinedia devices ---3
Graphics support ---3
<#¥r Sound card suppert ---3
[ ] HID Dewvices --->
(] USB support --->
< MMC/SDSSDI0 card support ---3
< » Sony WeworvStick card support (EXPERIMENTALY ---3
[ 1 Accessibility support ---3»
[#] LED Suppert ---»
<4 Beal Tiwe Clock ---3
[ 1 DHA Engine support ---3
[ 1 ¥oltage and Current Eegul ator Suppert ---3
< » Deerspace 1/0 drivers --->
CBUS support ---3»

wel ect < E=it > < Help >

Figure 3-4

3) Select USB Gadget Support

FMI &|2Zw USE &udio interface support

FMI 2|6 TSB &udio interface support

ADT dewices from Ontrak Contrel Swstens

USE 7-Seznent LED Display

USE Diawmond RioS00 support

ISE Lego Infrared Tower suppert

USE LCD driver support

5B BlackBerry recharge support

USE LED driver support

Cypress CY70ES:;mm USE driver support
Cypress USB thermometer driver support

5B Phidgets drivers

Siemens ID USE Mouse Fingerprint sensor support
Flan PCHCIA CardBus Adapter USE Client
Spple Cinewa Display support

USE 2.0 SVGA dongle support (MetZ22R0/515315)
5B LD driver

FlayStation 2 Trance Yikrator driver support
10 Warrior driver support

5B testing driver

18ight firmware loading support

0SB VST driwver

ISB Gadgzet Support ---

##% 0TG and related infrastructure %

WDl e A e o T A A e A e e A e e e e
B e Y Y L AV N Y T v

I

< » (PI0 based peripheral-only YEUS sensing "transceiver’
< » Philips [SP1301 with OHAP OTG
<& TWLA0Z0 TUSE Transceiwer Driwver
Sel ect, < Exit > < Help >
Figure 3-5
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4) The configuration of USB Gadget Support can be changed as showed in the following:

- TUSE Gadzet Support
[1] ehbugzing messages (DEVELOPMENT
[1] ebugging information files (DEVELOPMENT?
2 Mazimum YBUS Power usage (2- 500 mé)}

SE Peripheral Controller (Inventra HDEC USE Peripheral «TI, ADI. ..
SB Gadget Drivers

A T S
‘\/\/\/5

R

adget Zero (DEVELOPMENT:
thernet Gadget (with CDC Ethernet support)
adget Filesvstew (EXPERIMEMTAL}

Fil e-backed Storage Gadge

1l e- backed Storage Gadget testing wersion (MEWD
erial Gadzet (with CDC ACH and CDC OBEX support)

MIDI Gadget CEXPERIMENTAL)

rinter Gadzet
T2 Composite Device (Ethernet and &CH2

< Exit > < Help >

oAD ===d

3.4.3.2 Compilation

Figure 3-6

Save the configuration made and execute the following commands to recompile the kernel:

make ulmage

make modules

After completing the above steps, a new kernel image ulmage and a module file g_file_storage.ko

will be generated under the directory “arch/arm/boot” and “drivers/usb/gadget” respectively.

3.4.3.3 Test

To perform the test first you need to update the kernel image ulmage file, after that copy the

g_file_storage.ko file to the TF card and reboot the system. Now execute the following commands

to stimulate the TF card into USB mass storage device to use with PC:

root@shc8018:~# cd /media/mmcblkOp1/

root@sbc8018:/media/mmcblkOpl# insmod g_file_storage.ko file=/dev/immcblkOp1 stal

=0 removable=1

g_file_storage gadget: File-backed Storage Gadget, version: 20 November 2008

g_file_storage gadget: Number of LUNs=1

g_file_storage gadget-lunO: ro=0, file: /dev/mmcblkOp1

musb_hdrc musb_hdrc: MUSB HDRC host driver
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musb_hdrc musb_hdrc: new USB bus registered, assigned bus number 3

hub 3-0:1.0: USB hub found

hub 3-0:1.0: 1 port detected

musb g_file_storage gadget disconnected.

root@sbc8018:/media/mmcblkOpl# g_file_storage gadget: high speed config #1

Use the USB cable (USB mini B to USB A) to connect the development board and PC, PC will

prompt a message to indicate USB mass storage device is found; a new portable hard disk is

found and now users is ready to use the disk.

Please make sure that the kernel image has been updated, otherwise,

module g_file_storage.ko will fail to load and the similar tips will show:

insmod: cannot insert '/media/mmcblkOpl/g_file_storage.ko': Device or

resource busy

3.5 How to Update the System Image

The SBC8018 evaluation board NAND Flash by default comes with the installed Linux + 4.3-inch

screen display. It can be booted without connecting TF card once it's powered ON or RESET and

input “root” to enter Linux system. Please make sure the DIP switch [S7] settings are as below:

¥ £ 2 1
s
st
I+ MO

Figure 3-7 Boot-up from NAND Flash

3.5.1 Boot-up From Serial Port

1) First setup the hardware environment, make sure the DIP switch [S7] settings are as below:

Figure 3-8 Boot-up from Serial port

2) Now open the AlSgen_d800k006_Install_v1.7.exe:
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Windows XP -> Start -> All Programs -> Texas Instruments -> AlSgen for D800K006 -> UART Boot
Host

Add u-boot-uart-ais.bin [Directory: CD\linux\image\] to the “AlS-File” as below:

ONAP-L138 UART Boot Host, Ver. 1.0 =13

ATS File: | @

Serial FPort:COM1 | at 115200 baud A

Wait for BOOTME

©2010 Texas Instruments Inc.

Figure 3-9

3) Click the “Start” and power ON the evaluation board to boot-up from serial port.
4) Wait for moment, the target window will display “(Serial Port): Closing COM1.”, close the tool

and open the Hyperterminal to catch the serial port information.

User should open Hyperterminal and Input any key to enter U-BOOT

prompts in three seconds, or else U-BOOT will load default parameter.

3.5.2 How Update Images From Ethernet

The SBCB8018 evaluation board image can be updated through Ethernet port as well, in thi section
we will explain how to update the image using Ethernet port.
Below IP will be taken as an example;

PC:192.192.192.154

Evaluation board: 192.192.192.215

1) PCTFTP service
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a) Launch the “tftpd32.exe” from the CD under the folder CD\linux\tools, and click “Browse”

to set the sharing space, the directory will be giving an example as “d:\sbc8018”.

". Tftpd32 by Ph. Jounin M=
Current Directony |u:|:'\s|:u::8l]18 j Browse |
Serverinterface  |SRSER ISR TR Show Dir |
Thtp Server l Tttp Clent ] DHCP zerver | Syslog zerver ] Log wviewer ]

pEEer file start time | progrezs
< | >
About Settings Help

Figure 3-10 tftpd32 tool
b) Copy “u-boot-nand-ais.bin”, “ulmage_4.3", “ulmage_7”, “jffs2.img” from the CD under the
folder [CD\linux\image\] to the folder [d:\sbc8018]
¢) According to your LCD size (4.3" or 7"), rename the ulmage_xx as ulmage.
2) U-BOOT prompts
Input the below commands with U-BOOT prompts as below:
a) Setthe environment with “ipaddr” and “serverip”:

U-Boot > setenv ipaddr 192.192.192.215

U-Boot > setenv serverip 192.192.192.154

b) Erase the NAND Flash
U-Boot > nand erase

NAND erase: device 0 whole chip
Skipping bad block at  0x0ff80000
Skipping bad block at 0x0ffa0000

Skipping bad block at  0x0ffc0000
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Skipping bad block at 0x0ffe0000

OK
c) Write U-BOOT
U-Boot > tftp Oxc0700000 u-boot-nand-ais.bin;nand write.i 0xc0700000 0x20000
${filesize}
Using device
TFTP from server 192.192.192.154; our IP address is 192.192.192.215
Filename 'u-boot-nand-ais.bin'.
Load address: 0xc0700000
Loading: ####HHHHHHHHHHHHH
done
Bytes transferred = 210860 (337ac hex)
NAND write: device 0 offset 0x20000, size 0x337ac
210944 bytes written: OK
U-Boot > nandecc sw

SW ECC selected

d) Write kernel

U-Boot > tftp Oxc0700000 ulmage;nand write.i 0xc0700000 0x200000 ${filesize}

Using device

TFTP from server 192.192.192.154; our IP address is 192.192.192.215

Filename ‘'ulmage'.

Load address: 0xc0700000

Loading: #atHHHHHHHHHHHH R
HHHH R R R R
HHH B

done

Bytes transferred = 2299460 (231644 hex)

NAND write: device 0 offset 0x200000, size 0x231644
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2299904 bytes written: OK

e) Write file system
U-Boot > tftp 0xc2000000 jffs2.img;nand write.i 0xc2000000 0x600000 ${filesize}
Using device
TFTP from server 192.192.192.154; our IP address is 192.192.192.215
Filename 'jffs2.img'.
Load address: 0xc2000000
Loading: #HHHHHHHHHHHHHH
HHRHHHT
FHHH A R R R R R R R R R
HEHHH T T R R T T T R T
B R R R T #T
HEt T
i
done

Bytes transferred = 3889116 (3b57dc hex)

NAND write: device 0 offset 0x600000, size 0x3b57dc

3889152 hytes written: OK

3) NAND Flash boot-up

For NAND flash boot up make sure the DIP switch [S7] settings are as below:

¥ £ 2 1
aia
st
I+ MO

Figure 3-11 Boot-up from NAND Flash
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3.6 Test Procedures

3.6.1 Various Tests Scenario

3.6.1.1 LED Testing
The SBC8018 evaluation board is having following LEDs:
D5 is power LED
D2 is heartbeat LED
D3 and D4 are user’s LED
The following operation can be carried out using HyperTerminal:
1) Control D3
root@sbc8018:~# echo 0 > /sys/class/leds/led2/brightness
root@sbc8018:~# echo 1 > /sys/class/leds/led2/brightness
2) Control D4
root@sbcB8018:~# echo 0 > /sys/class/leds/led3/brightness

root@sbc8018:~# echo 1 > /sys/class/leds/led3/brightness

3.6.1.2 Key Switch Testing

The SBCB8018 evaluation board is having three users key switches S8, S9 and S10; users can

perform the following testing:
First, enter the following command, and then press the S9, S8, S10 keys
root@sbc8018:~# hexdump /dev/input/eventO
0000000 06f5 49e5 206f 0001 0001 0100 0000 0000
0000010 06f5 49e5 208d 0001 0000 0000 0000 0000
0000020 06f5 49e5 1c89 0003 0001 0100 0001 0000
0000030 06f5 49e5 1ca9 0003 0000 0000 0000 0000
0000040 07b5 49e5 d3fd 0008 0001 0101 0000 0000
0000050 07b5 49e5 d41d 0008 0000 0000 0000 0000
0000060 07b5 49e5 63d9 000b 0001 0101 0001 0000

0000070 07b5 49e5 63fc 000b 0000 0000 0000 0000
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0000080 07b6 49e5 2569 000c 0001 0102 0000 0000
0000090 07b6 49e5 2586 000c 0000 0000 0000 0000
00000a0 07b6 49e5 a922 000e 0001 0102 0001 0000

00000b0 07b6 49e5 a941 000e 0000 0000 0000 0000

Press CONTROL+C to quit the test. The back of the test is the same.

3.6.1.3 Touch Screen Testing

1) Run the following command to start the calibration process:
root@sbcB8018:~# ts_calibrate

Then follow the LCD prompt, click the "+" icon 5 times to complete the calibration

2) Calibration is complete, now enter the following commands for Touch Panel Test:
root@sbc8018:~# ts_test

Follow the LCD prompts to choose draw point OR draw line test.

3.6.1.4 RTC Testing
The development board contains the hardware clock for save and to synchronize the system time.
User can perform the RTC test by following steps below:
1) Setthe system time as Mon Dec 05 20:00:00 2011
root@sbc8018: # date 120520002011
Mon Dec 08 20:00:00 UTC 2011
2) Write the system clock into RTC
root@sbc8018:~# hwclock -w
3) Readthe RTC
root@sbc8018: # hwclock
Mon Dec 08 20:00:00 UTC 2011
Now the RTC clock has been set as Dec 05 2011; the system clock will be saved in the hardware

clock.
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4) Restart the system, enter the following commands to renew the system clock
root@sbc8018: # hwclock -s
root@shc8018: # date
Mon Dec 08 20:00:00 UTC 2011

Now the system time has been set as hardware time.

The SBC8018 Development board RTC battery can use model CR1220,

user needs to prepare themselves.

3.6.1.5 TF Card Testing
1) Firstinsertthe TF card in the board, the system will automatically mount the file system of the
TF card under the directory /media:
root@shbc8018:~# cd /media/
root@sbc8018:/media# Is
card hdd mmcblkOpl ram union
cf mmcl net realroot
2) Enter the following command to see the TF card content:

root@SBC80root@sbc801818:/media# |s mmcblkOpl/

flash-uboot.bin u-boot.bin x-load.bin.ift_for_ NAND
mlo ulmage
ramdisk.gz ubi.img

3.6.1.6 USB Devices Testing
In the USB DEVICE testing, a USB cable is used to connect the miniUSB interface of the
development board and the USB interface of the PC; for the computer end, the development

board is recognized as a network device.

1) The computer needs to be installed with Linux USB Ethernet driver, please refer to Appendix

1l for detailed installation procedure.
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2) After booting the system, please configure the system using the below commands through
HyperTerminal:
root@Shc8018:~# ifconfig usb0 192.168.1.115
root@Sbc8018:~# ifconfig
lo Link encap:Local Loopback
inet addr:127.0.0.1 Mask:255.0.0.0
UP LOOPBACK RUNNING MTU:16436 Metric:1
RX packets:26 errors:0 dropped:0 overruns:0 frame:0
TX packets:26 errors:0 dropped:0 overruns:0 carrier:0
collisions:0 txqueuelen:0

RX bytes:2316 (2.2 KiB) TX bytes:2316 (2.2 KiB)

usb0 Link encap:Ethernet HWaddr 5E:C5:F6:D4:2B:91
inet addr:192.168.1.115 Bcast:192.168.1.255 Mask:255.255.255.0
UP BROADCAST RUNNING MULTICAST MTU:1500 Metric:1
RX packets:253 errors:0 dropped:0 overruns:0 frame:0
TX packets:43 errors:0 dropped:0 overruns:0 carrier:0
collisions:0 txqueuelen:1000
RX bytes:35277 (34.4 KiB) TX bytes:10152 (9.9 KiB)
3) After the development board is configured, please click My Computer>>Network
Neighborhood>>Check Network Connection; you can see a virtual network adapter is added at
the PC end.
4) Now go to the virtual network adapter properties and select “Internet Protocol (TCP/IP)” to

configure the IP address of the virtual network adapter:
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Internet Protocol (TCP/IP) Properties

General |

You can get IP settings azsigned automatically if pour netwark, suppaorts
thiz capability. Othenwize, you need to azk your nebwork, administratar for
the appropriate [P zettings.

() Obtain an IP address automatically
() Uze the follawing IP address:

IP address: 192 .168. 1 . 15 |
Subnet mask: | 255255 .25 . 0 |
Default gateway: (192188 1 . 1 |

(%) Uze the follawing DNS server addresses:
Prefered DMS zerver: | . . . |

Alternate DS server: | . . . |

[ Ok H Cancel ]

Figure 3-12
5) Now use the ping command from the HyperTerminal to test whether the development board
IP address has been configured successfully.
root@Sbhc8018:~# ping 192.168.1.15
PING 192.168.1.15 (192.168.1.15): 56 data bytes
64 bytes from 192.168.1.15: seq=0 ttl=128 time=0.885 ms
64 bytes from 192.168.1.15: seq=1 ttI=128 time=0.550 ms
6) If you receive ping response like above, indicates the successful communication between the

board and the PC.

IP address of the network adapter configured in OTG cannot be the same

as that of Ethernet interface.
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3.6.1.7 USB HOST Testing
1) Connect the USB flash disk, the system will automatically mount the file system of the USB
flash disk under the directory /media:

root@sbc8018:~# cd /media/

root@shbc8018:/media# Is

card hdd mmcblkOpl ram sdal

cf mmcl net realroot union

2) You can see the USB flash disk contents using the below command:

root@sbc8018:/media# |Is sdal/

flash-uboot.bin u-boot.bin x-load.bin.ift_for_NAND
mlo ulmage
ramdisk.gz ubi.img

3.6.1.8 Audio Testing
The board has multiple audio input and output interface, we can use the “alsa-utils” utility available
in the file system to test the board audio, in order to test the audio please follow the below steps;
1) Recording Test:
To test the recording functionality, first plug-in the microphone and use the below command to start
the recording:

root@Sbc8018:~# arecord -t wav -c 1 -r 44100 -f S16_LE -v k

Recording WAVE 'k’ : Signed 16 bit Little Endian, Rate 44100 Hz, Stereo

Plug PCM: Hardware PCM card 0 ‘omap3evm' device 0 subdevice 0

Its setup is:
stream : CAPTURE
access :RW_INTERLEAVED
format :S16_LE

subformat :STD

channels 2
rate 144100
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exactrate :44100 (44100/1)
msbits 116
buffer_size :22052
period_size :5513
period_time : 125011
tstamp_mode : NONE
period_step :1
avail_min : 5513
period_event : 0
start_threshold : 1
stop_threshold : 22052
silence_threshold: 0

silence_size : 0

boundary : 1445199872
appl_ptr :0
hw_ptr :0

2) Playback Testing:
To playback, plug-in the headphones and enter the below command to hear what you have just
recorded,;

root@Sbc8018:~# aplay -t wav -c 2 -r 44100 -f S16 _LE -v k

Playing WAVE 'k’ : Signed 16 bit Little Endian, Rate 44100 Hz, Stereo

Plug PCM: Hardware PCM card 0 ‘omap3evm' device 0 subdevice 0

Its setup is:
stream : PLAYBACK
access :RW_INTERLEAVED
format :S16_LE

subformat :STD

channels 12
rate 144100
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exactrate :44100 (44100/1)
msbits 116
buffer_size :22052
period_size :5513
period_time : 125011
tstamp_mode : NONE
period_step :1
avail_min : 5513
period_event : 0
start_threshold : 22052
stop_threshold : 22052
silence_threshold: 0

silence_size : 0

boundary : 1445199872
appl_ptr :0
hw_ptr :0

3.6.1.9 Network Testing
1) The board is having a 10/100M self-adapting DM9000 network card, users can directly
connect the board to the LAN network and enter the following commands for network testing:
root@sbc8018:~# ifconfig eth0 192.192.192.203
root@sbc8018:~# # ifconfig
ethO Link encap:Ethernet HWaddr 00:11:22:33:44:55
inet addr:192.192.192.203 Bcast:192.192.192.255 Mask:255.255.255.0
UP BROADCAST MULTICAST MTU:1500 Metric:1
RX packets:0 errors:0 dropped:0 overruns:0 frame:0
TX packets:0 errors:0 dropped:0 overruns:0 carrier:0
collisions:0 txqueuelen:1000
RX bytes:0 (0.0 B) TX bytes:0 (0.0 B)

Interrupt:185 Base address:0x2000
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root@sbc8018:~# ping 192.192.192.154

PING 192.192.192.154 (192.192.192.154): 56 data bytes

64 bytes from 192.192.192.154: seq=0 ttl=128 time=4.486 ms
64 bytes from 192.192.192.154: seq=1 ttI=128 time=0.336 ms
64 bytes from 192.192.192.154: seq=2 ttl=128 time=0.336 ms

2) If you receive ping response like above, indicates the successful network communication.

The IP address in the network card of development board and PC should
be in the same network segment, for example: 192.192.192.x. Press

CONTROL+C to quit the test.

3.6.1.10 Camera Testing
If you have bought the specific camera module for SBC8018 evaluation board, first connect the
CAMERA module and LCD screen to the board. To install the camera please use the camera
drivers from [drivers/media/video/tvp514x.c]. After installation of camera module enter the
following command:

root@Shbc8018:~# camera_test -i 0 -n 3 -f nv16 -S -s 720x576 /dev/videoO

The framebuffer device was opened successfully.

fscreen line_length : 960

vscreen 480x272, 16bpp, xoffset=0, yoffset=0

The framebuffer device mapped successfully.

Device /dev/videoO opened: DA850/OMAP-L138 Video Capture.
Once the above commands are executed you should be able to see the captured images from the

camera module on your LCD screen.

3.6.1.11 SATA Testing
1) Connect SATA device to the SATA connector marked with J32, and connect the SATA device
power cable to the J37 connector on the evaluation board.

2) Now power ON the evaluation board, you can see the SATA device contents by using the
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following command:

3.7 Application Development

This section will introduce you to the various steps involved in application development process:
Step 1. Code Editing
Source Code: led_app.c
Application: Blinking D3 and D4 LEDS
#include <stdio.h>
#include <unistd.h>

#include <fcntl.h>

#define LED_D3 "/sys/class/leds/led2/brightness"

#define LED_D4 "/sys/class/leds/led3/brightness"

int main(int argc, char *argv[])
{

int i;

intf_ledl, f led2;

unsigned char datl, dat2;

if((f_led1 = open(LED_D3, O_RDWR)) < 0){

printf("error in open %s", LED_D3);
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return -1;

}

if((f_led2 = open(LED_D4, O_ RDWR)) < 0){
printf(“error in open %s",LED_D4);

return -1;

for(i=0; i < 100; i++) {
datl = (i & 0x1)? 1" '0";

dat2 = (i & 0x2)? '1": '0";

write(f_led1, &datl, sizeof(datl));

write(f_led2, &dat2, sizeof(dat2));

usleep(300000);

return O;
}
Step 2: Cross-compilation

arm-none-linux-gnueabi-gcc led_app.c -o led_app

Step 3: Download and run
Now download the compiled code into the evaluation board through TF card, USB flash disk or
network, locate the the directory with the led_app file and enter the following commands and press
Enter, to run led_app in the background.

chmod a+x ./led_app

Jled_app
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Chapter 4 WinCE Operating System

4.1 Introduction

This section will introduces you to the SBC8018 evaluation board application development using
Windows Embedded CE 6.0 R3, software resources on the disc, software features, installation of

development environment, and how to “sysgen” and build BSP (board support package).

4.2 Software Resources

BSP (Board Support Package)
CD\WINCE600\BSP\OMAPL138_AM18X.rar

CD\WINCE600\BSP\OMAPL13X_TI_V1.rar

Windows Embedded CE 6.0 R3 sample project

CD\WINCEG600\sample projecttOMAPL138 AM18X_SAMPLE.rar

Pre-compile image

CD\WINCEG600\Image\

EBOOTNANDFLASH.nbO Eboot for NAND boot
NK.bin WinCE runtime image (packed)
NK.nb0O WinCE runtime image
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4.3 Software Features
Resources of BSP:
Table 4-1
Source code /
Catalog Item
binary
NAND Source
EBOOT NOR source
SPI Source
KILT(EMAC) Source
Boot parameter Source
Watchdog Source
RTC Source
System timer Source
Interrupt controller Source
MMU Source
Serial Debug Port Source
Kernel Profiler-use timer0, high 32 bits Source
Library Abstractions (PSC, PLL, GPIO,
OAL Source
abstractions)
Power management: CPU idle support
(ARM wait for interrupt in OEMIdle())
This BSP release implements support for
some basic power management (PM). The
drivers support DO and D4 states and | Source
system suspend / resume support is
implemented.
There is no support for voltage or frequency
scaling.
Driver EDMA driver Source
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12C driver Source
SPI driver Source
MCASP driver Source
AIC3106 Audio driver Source
USB 1.1 OHCI HOST driver Source
USB OTG 2.0 HOST driver Source
USB OTG 2.0 FUNCTION driver Source
USB OTG driver Source
USB CDMA driver Source
Raster LCD Display driver Source
Character LCD Display driver Source
NDIS Ethernet driver Source
NAND FLASH driver Source
Serial driver Source
UPP driver Source
SD/MMC HOST controller driver Source
PWM driver Source
Notification LED driver Source
Touch Screen driver Source
McBSP driver Source
VPIF driver Source
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4.4 System Development

4.4.1

Installation of IDE(Integrated Development Environment)

Please install items below to windows XP/Vista:

1)
2)
3)
4)
5)
6)
7)
8)

9)

Visual Studio 2005

Visual Studio 2005 SP1

Visual Studio 2005 SP1 Update for Vista (vista system require)
Windows Embedded CE 6.0 Platform Builder

Windows Embedded CE 6.0 SP1

Windows Embedded CE 6.0 R2

Windows Embedded CE 6.0 Product Update Rollup 12/31/2008
Windows Embedded CE 6.0 R3

Windows Embedded CE 6.0 Product Update Rollup 12/31/2009

10) ActiveSync 4.5

11) Windows Mobile 6 Professional SDK

CD does not provide WIinCE development environment tools, please down

from: http://www.microsoft.com/download/en/default.aspx

4.4.2 Extract BSP and project files to IDE

The following preparations should be made:

1)

2)

3)

4)

Extract CDROM\WINCEG600\bsp\OMAPL138_AM18X.rar] to [C:\WINCE600\PLATFORM]
directory.

Extract CDROM\WINCE600\bsp\OMAPL13X_TI_V1.rar] to
[C:\WINCEG600\PLATFORM\COMMON\SRC\SOC].

Copy CD directory [CDROM\WINCEG600\ sample project \ OMAPL138 AM18X_ SAMPLE]
to [C:\WINCE600\0SDesigns] directory.

Please modify the LCD module type before sysgen and build BSP:
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For 4.3” LCD
If you are using 4.3” LCD screen modify the line as shown below at
[platform/SBC8018/SBC8018.bat]

set BSP_LCD43INCH=1

For 7” LCD
If you are using 77 LCD screen modify the line as shown below at
[platform/SBC8018/SBC8018.bat]

set BSP_LCD43INCH=

The default installation path of the Windows Embedded CE 6.0 in this

context is [C:\WINCE600].

4.4.3 Sysgen & Build BSP

For “sysgen” and to build the BSP please follow the below steps:

1) Open the existing project file OMAPL138_AM18X_SAMPLE.sIn located at
[C:\WINCE600\OSDesigns\OMAPL138_AM18X_SAMPLE].

2) Click [Build-> Build Solution] in vs2005 to “sysgen” and build BSP.

3) Once you finish “sysgen” and build process, “EBOOTNANDFLASH.nb0”, “NK.bin”,
“NK.nb0” will be created at the directory location
[C:\WINCE600\OSDesigns\OMAPL138_AM18X_SAMPLE\OMAPL138 AM18X_SAMPL
E\RelDiInOMAPL138 AM18X_ARMV4l_Release]. Now copy “EBOOTNANDFLASH.nb0”
to the directory [D:\sbc8018\bin] and copy “NK.bin”, “NK.nb0” to the TF card (FAT/FAT32
format).

4) Now to update the system image please refer to the section 4.5 below “How to Update

the System Image”
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4.4.4 Source code path of all drivers in BSP

Table 4-2

EDMA driver bsp\OMAPL138 AM18X\SRC\DRIVERS\EDMA
bsp\OMAPL138_AM18X\SRC\DRIVERS\I2C

12C driver
bsp\OMAPL13X_TI_V1\I2C
bsp\OMAPL13X_TI_V1\SPI

SPI driver

bsp\OMAPL138_AM18X\SRC\DRIVERS\SPI

MCASP driver

bsp\OMAPL13X_TI_V1\MCASP

AIC3106 Audio driver

bsp\OMAPL138 AM18X\SRC\DRIVERS\WAVEDEV?2

USB 1.1 OHCI Host driver

OMAPL138_AM18X\SRC\DRIVERS\USB\OHCI

USB 2.0 OTG Host driver

bsp\OMAPL13X_TI_V1\USB\USBH

bsp\OMAPL138 AM18X\SRC\DRIVERS\USB\USBH

USB 2.0 OTG Function

Driver

bsp\OMAPL13X_TI_V1\USB\USBFN

bsp\OMAPL138_AM18X\SRC\DRIVERS\USB\USBFN

USB 2.0 OTG driver

bsp\OMAPL13X_TI_V1\USB\USBOTG

bsp\OMAPL138_AM18X\SRC\DRIVERS\USB\USBOTG

USB CDMA driver

bsp\OMAPL13X_TI_V1\USB\USBCDMA

bsp\OMAPL138_AM18X\SRC\DRIVERS\USB\USBCDMA

Raster LCD Display driver

bsp\OMAPL13X_TI_V1\DISPLAY

bsp\OMAPL138_AM18X\SRC\DRIVERS\DISPLAY

User Manual
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Character LCD Display

driver

bsp\OMAPL138_AM18X\SRC\DRIVERS\CHARLCD

bsp\OMAPL13X_TI_V1\LIDD

NDIS Ethernet driver

bsp\OMAPL13X_TI_V1\EMAC

bsp\OMAPL138 AM18X\SRC\DRIVERS\EMAC

NAND Flash driver

bsp\OMAPL138 AM18X\SRC\COMMON\NAND

bsp\OMAPL138 AM18X\SRC\DRIVERS\NAND

Serial driver

bsp\OMAPL13X_TI_VI\SERIAL

bsp\OMAPL138_AM18X\SRC\DRIVERS\SERIAL

UPP driver

bsp\OMAPL13X_TI_V1\UPP

bsp\OMAPL138 AM18X\SRC\DRIVERS\UPP

SD/MMC Host Controller

driver

bsp\OMAPL13X_TI_V1\SDHC
bsp\OMAPL138_AM18X\SRC\DRIVERS\SDHC

bsp\OMAPL13X_TI_V1\SDBUS

PMW driver

bsp\OMAPL13X_TI_V1\PWM

bsp\OMAPL138_AM18X\SRC\DRIVERS\PWM

Notification LED driver

bsp\OMAPL138 AM18X\SRC\DRIVERS\NLED

Touch Screen driver

bsp\OMAPL138_AM18X\SRC\DRIVERS\TOUCH

McBSP driver

bsp\OMAPL13X_TI_V1\MCBSP

bsp\OMAPL138_AM18X\SRC\DRIVERS\MCBSP

VPIF drive

bsp\OMAPL138_AM18X\SRC\DRIVERS\CAMERA\LAYER

ED
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For more information on WIinCE driver development please refer to below location for more

documents for Windows Embedded CE 6.0:

Start->
All programs->
Microsoft visual Studio 2005->
MicroSoft Visual Studio Document->
Content(C)->

Windows Embedded CE 6.0->

Develop a Device Driver.

Figure 4-1

4.5 How to Update System Image

The SBC8018 evaluation board supports “NK.bin” or “NK.nb0” boot from TF Card and NAND flash,

this chapter will introduce you to the both of these system boot methods.

4.5.1 Downloading EBOOT to NAND Flash

EBOOT can be downloaded to NAND Flash by using “sfh_ OMAP-L138.exe” tool (.net framework
is require to run this utility; you can download.net framework “dotNetFx40_Full_x86_x64.exe” from
Microsoft).

1) Make sure you have connected the evaluation board to the PC using serial cable.

2) DIP Switch settings; S7-3 and S7-4 should be ON, other switch should be OFF.

¥ £ 2 I

AhEa
il

ER O

Figure 4-2

3) Copy the folder “bin” from the CD folder [CD\WINCEG600\tools] to the folder [D:\sbc8018].

4) Now according to your LCD screen size, copy the “EBOOTNANDFLASH.nb0” from the CD
folder [WINCE600\Image\4_3INCH or WINCE600\image\7INCH] to the folder
[D:\sbc8018\bin].

5) Now start the Windows Command Prompt; Click Start -> All Programs -> run, and input

“CMD” on the pop-up dialog to enter Windows Command Prompt(cmd.exe), how enter the
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6)

7)

8)

below commands in command prompt.:

d:

cd \sbc8018

Run the flash tool to erase the NAND Flash: (change COM port if required)

sfh_ OMAP-L138.exe -erase -targetType AM1808 -flashType NAND -p COM1

Power ON the Kit. You should see the erase cycle in progress, wait until it completes, and
then power OFF the kit. Note: If the erase sequence does not complete after 30 seconds

press a key to terminate the “sth_ OMAP-L138.exe” program and start the process again.

Run the flash tool to write an appropriate UBL(First Bootloader) and EBOOT to flash (change
COM port if required).

sfh_OMAP-L138.exe -flash -targetType AM1808 -flashType NAND -v -p COM1

-appStartAddr  0xc7f60000 -appLoadAddr  0xc7f60000 arm-nand-ais-456mhz.bin

EBOOTNANDFLASH.nbO

9)

Power ON the Kit. You should see write cycle in progress, wait until it completes.
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Flashing UBL arm—nand—ais—456mhz.bhin (13776 bytes)> at Bx000600EB0

Target:= SENDIMG
Target: BEGIHN
i@88:x [
Image data transmitted over UART.

Target: DONE
188 [
UBL programming complete

Target: SENDIHNG
Target: DONE

Flashing application EBOOTNANDFLASH.nhB <{262144 bhytes>» at BxPHAA10B6A

Target:= SENDIMG
Target: BEGIN
188 [
Image data transmitted over UART.

Target: DOME
Application programming complete

Target: Mumber of bhlocks needed for header and data: OxOx00000003
Target: Attempting to start in block number BxBxBABBBEHAG .

Target: Magicnum: BxBx55424CBE

Target: Entrypoint: BxBxC7FeHHAA

Target: NHumpage: BxBxB000BBEH0

Target: Writing header and image data to Block BxPB00BB06. Page OxB00008

Target: DONE
Target: DONE

Operation completed successfully.

Figure 4-3

10) Power OFF the Kit and set DIP switches as; S7-1 to ON, all others to OFF.

ﬁﬁﬁ@
sl
J4 MO

Figure 4-4

11) Start your serial terminal application, Hyper Terminal (115200 baud, 8N1)
12) Now power ON the evaluation board and you will see the system boot up with the new

EBOOT image.
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4.5.2 Update TF Card NK runtime images

1) Format TF card
Format the TF Card in FAT/FAT32 file system.
2) Copy NK runtime image
a) Navigate to the directory [WINCE600/image/lcd7inch] or [WINCE600/image/lcd4.3inch],
according to the LCD size.
b) Copy “NK.nb0/NK.bin” to TF card.
3) Change the EBOOT settings to boot NK from TF Card
Insert the TF card into the evaluation board, turn the power ON and press space key to enter into
the EBOOT menu.
a) Press the key [2] -> [2] -> [2] step by step to select boot NK from TF card as shown
below:
Booting with TI UBL
Device OPP (456MHz, 1.3V)01
Microsoft Windows CE Bootloader Common Library Version 1.4 Built Sep 23 2011 15:29:43
INFO:OALLogSetZones: dpCurSettings.ulZoneMask: Oxb
Microsoft Windows CE EBOOT 1.0 for AM1808 OMAPL138/AM18X EVM. Built Sep 23 2011 at
15:30:38
BSP version 1.3.0, SOC version 1.3.0
CODE : 0xC7F60000 -> 0xC7FA0000
DATA : 0OxC7FA0000 -> 0xC7FE0000
STACK : 0xC7FE0000 -> 0xC8000000
Enabled OAL Log Zones : ERROR, WARN, INFO,
Platform Init done
System ready!
Preparing for download...
Predownload...
FMD: ReadID (Mfg=0x2c, Dev=0xda)
WARN: Invalid boot configuration found (using defaults)

Lan MAC: 00:08:ee:00:00:00
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INFO: MAC address: 00:08:ee:00:00:00
WARN: Invalid BSP_ARGS data found (using defaults)

WARN: Unable to get hardware entropy

Hit space to enter configuration menu 2

Main Menu

[1] Show Current Settings

[2] Boot Settings

[3] Network Settings

[5] Video Settings

[6] Save Settings

[7] Peripheral Tests

[R] Reset Settings To Default Values

[0] Exit and Continue

Selection: 2

Boot Settings

[1] Show Current Settings

[2] Select Boot Device

[3] Select Boot Delay

[4] Select Debug Device

[5] Force Clean Boot

[6] Write Download RAM NK to Flash

[7] Set Device ID String
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[8] Allow DSP to Boot

[0] Exit and Continue

Selection: 2

element Iul\S

Select Boot Device

[1] EMAC
[2] NK from SD
[3] NK from NAND flash

[0] Exit and Continue

Selection (actual NK from SD): 2

Boot device set to NK from SD

b) Press the key [0] -> [0] by step by step to start the system from SD card, and you would

see the following message on your PC Hyper Terminal:

Boot Settings

[1] Show Current Settings
[2] Select Boot Device

[3] Select Boot Delay

[4] Select Debug Device

[5] Force Clean Boot

[6] Write Download RAM NK to Flash

[7] Set Device ID String
[8] Allow DSP to Boot

[0] Exit and Continue
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Selection: 0

Main Menu

[1] Show Current Settings

[2] Boot Settings

[3] Network Settings

[5] Video Settings

[6] Save Settings

[7] Peripheral Tests

[R] Reset Settings To Default Values

[0] Exit and Continue

Selection: O
Device ID set to AM1808-0
BLFlashDownload: LogicalLoc - 0x01C40000
Loading from SD card
+ReadNKFromSDMMC
ReadFileFromSDMMC: reading file 'nk.bin’
SDBootPDD: PDD_SDInitializeHardware: MMCSD
SDBootMDD: SDinitializeHardware: SD card detected
SDBootMDD: SDinitializeHardware: V2.0 card detected
SDBootMDD: SDinitializeHardware: timeOut = 0
SDBootMDD: SDInitializeHardware: timeOut = 1
SDBootMDD: SDInitializeHardware: timeOut = 2
SDBootMDD: SDInitializeHardware: timeOut = 3
SDBootMDD: Card address is 1234
SDBootMDD: 4-bit data bus selected

InitMasterBootRecord: Partition 0, type 12
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InitMasterBootRecord: Partition 0, FAT32, start 0x7e00, length 0x753f8200
InitPartition: Offset 0x7e00, length 0x753f8200

ReadFileFromSDMMC: file size = 16138467 bytes

UnpackBINImage: unpacking binary from 0xc2000000

UnpackBINImage: Image start = 0x80000000

UnpackBINImage: Image length = 0x102fd2c

UnpackBINImage: record 0, start=0x80000000, length=0x4, checksum=0x1eb
UnpackBINImage: record 296, start=0x0, length=0x80001000, checksum=0x0

CheckCEImage: checking image at 0Oxc0000000

ROMHDR (pTOC = 0Oxc102de3c)

DLL First : 0x4001c001
DLL Last : 0x40b5c097
Physical First : 0x80000000
Physical Last : 0x8102fd2c
Num Modules 181
RAM Start : 0x81030000
RAM Free : 0x8103f000
RAM End : 0x8373f800
Num Copy Entries : 2

Copy Entries Offset : 0x804f4fd4
Prof Symbol Length : 0x00000000
Prof Symbol Offset : 0x00000000
Num Files : 73
Kernel Flags : 0x00000000
FileSys RAM Percent : 0x30303030
Driver Glob Start  : 0x00000000
Driver Glob Length : 0x00000000

CPU : 0x01c2
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MiscFlags : 0x0002
Extensions : 0x80001070
Tracking Mem Start : 0x00000000

Tracking Mem Length : 0x00000000

Image Start ........ 0x00000000
Image Size ......... 0x00000000
Image Launch Addr .: 0x00000000
Image ROMHDR ......: 0x00000000
Boot Device/Type ... 3/6
ADEhellounch Windows Embedded CE by jumping to 0xc0000000...
Windows CE Kernel for ARM (Thumb Enabled) Built on Oct 20 2009 at 18:39:19
OEMInit: init.c built on Sep 28 2011 at 15:51:27.
BSP version 1.3.0, SOC version 1.3.0
INFO:OALLogSetZones: dpCurSettings.ulZoneMask: Oxf
WARN: Updating local copy of BSP_ARGS
Intr Init done...
Timer Init done...
+OALDumpClocks
Clock Configuration :
Reference Clock 0 .. 24000000 Hz
PLLO ............. 456000000 Hz
PLLO:SYSCLK1 ..... 456000000 Hz (DSP Subsystem)
PLLO:SYSCLK?2 ..... 228000000 Hz
(UART,EDMA,SPI,MMC/SD,VPIF,LCDC,SATA,uPP,USB2.0,HPI,PRU)

PLLO:SYSCLKS ..... 91200000 Hz (EMIFA)

PLLO:SYSCLK4 ..... 114000000 Hz (INTC, SYSCFG, GPIO, PSC, I12C1, USB1.1,

EMAC/MDIO, GPIO)

PLLO:SYSCLKS ..... 152000000 Hz (reserved)
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PLLO:SYSCLKG® ..... 456000000 Hz (ARM Subsystem)

PLLO:SYSCLKY ..... 76000000 Hz (EMAC)

PLLO:AUXCLK ...... 24000000 Hz (12C0, Timers, McASPO serial clock, RTC, USB2.0
PHY)
PLLD ............. 264000000 Hz
PLL1:SYSCLK1 ..... 264000000 Hz (DDR2/mDDR PHY)
PLL1:SYSCLK2 ..... 132000000 Hz (Optional for; McCASPO,McBSP,ePWM,eCAP,SPI1)
PLL1:SYSCLKS ..... 88000000 Hz (PLLO input)
-OALDumpClocks
-OEMInit

PINMUX14=0x00000000
PINMUX15=0x00000000
PINMUX16=0x22222200
PINMUX17=0x22222222
PINMUX18=0x22000022
PINMUX19=0x02000022

OEMGetExtensionDRAM: Added 0x84400000 -> 0x88000000

OEM: Cleaning system hive

OEM: Cleaning user profiles

WARN: Updating local copy of BSP_ARGS

OEM: Not cleaning system hive

FMD: ReadID (Mfg=0x2c, Dev=0xda)

MICBIASHardwareContext::Init 555

Adapter's MAC address is 00:08:EE:00:00:00

SDHC +Init

SDHC Active RegPath: Drivers\Active\21

+SDHCPDD_Init: Ctrl 0, Entry

SDHC -Init
SDHC +Open

SDHC +Open
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SDHC_CARD_DETECT =1

SDHC CommandCompleteHandler: Command response timeout
SDHC CommandCompleteHandler: Command response timeout
SDHC CommandCompleteHandler: Command response timeout
SDHC CommandCompleteHandler: Command response timeout
SDHC CommandCompleteHandler: Command response timeout
SDHC CommandCompleteHandler: Command response timeout
SDHC CommandCompleteHandler: Command response timeout

SDHC CommandCompleteHandler: Command response timeout
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4.5.3 Downloading NK.bin to NAND flash

This section will introduce you how to download “NK.bin” to NAND flash via Ethernet using
VS2005 utility:
1) Confirm you have performed the release build in
C:\WINCE600\0SDesigns\OMAPL138 AM18X_SAMPLE\
OMAPL138 AM18X_SAMPLE.sIn.
2) Connect PC and SBC8018 evaluation board using with RJ45 Cable.

3) DIP switch position: S7-1 to ON position, other switches to OFF position:

¥ £ 2 1
aia
st
I+ MO

Figure 4-5 Boot up from NAND Flash

4) Select EMAC as boot media in EBOOT menu, press key [2]->[2]->[1] , steps by step as below:

Select Boot Device

[1] EMAC
[2] NK from SD
[3] NK from NAND flash

[0] Exit and Continue

Selection (actual NK from SD): 1

Boot device set to EMAC

5) Press [6] -> [y], this will enable the NK download to NAND Flash in EBOOT menu:

Boot Settings

[1] Show Current Settings

Copyright © 2011 by element14 User Manual



element Iul\S

[2] Select Boot Device

[3] Select Boot Delay

[4] Select Debug Device

[5] Force Clean Boot

[6] Write Download RAM NK to Flash

[7] Set Device ID String

[8] Allow DSP to Boot

[0] Exit and Continue

Selection: 6

Enable Write Download RAM NK to Flash (actually disabled) [y/-]: y

Write Download RAM NK to Flash enabled

6) Press key [0] to return to EBOOT main menu, now press key [3] to set the network property.
Setting the DHCP, IP, NETMASK according to your network environment, confirm that the IP,

NETMASK of evaluation board is in the same sub network of your PC.

7) Press key [0] to return to EBOOT main menu. Now press key [0] to prepare the “NK.bin”
download process from PC to the NAND flash. You will see the below message on your PC
Hyper Terminal window:

INFO: Boot device uses MAC 00:08:ee:ff:ff:ff
+EbootSendBootmeAndWaitForTftp
Sent BOOTME to 255.255.255.255
Sent BOOTME to 255.255.255.255
Sent BOOTME to 255.255.255.255
Sent BOOTME to 255.255.255.255
Sent BOOTME to 255.255.255.255
Sent BOOTME to 255.255.255.255

Sent BOOTME to 255.255.255.255
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8) Click [Target->Connectivity Options] in VS2005 Menu, you will see a Connectivity Options pop

up window like below, select Ethernet from Download drop down menu:

& Target Dewice Connectivity Options |Z”E|[zl

Device Configuration

Add Device Target Dewice:

CE Dawi -
Delete Device | ket J
Downlaad:
Service Configuration |Ethernet
Kernel Service Magp [ AM1805-B5535 )

Core Service Settings

Transport:

Service Status |Ethernet ﬂ Settings

[ &M1803-B5535 )

Debugzer:

[KdStub | Settings

[ Frompt On Error )

Apply Close Help

Target dewice core serwice settings are updated.

Figure 4-6
9) Now click on Settings button (located in the right of Download drop down menu), this will pop
up another window as shown below. If the network settings are correct and network cable OK,
you would see AM1808-65535 in Active target devices edit box, select device AM1808-65535
and click [OK] button to go back to Connectivity Options dialog, click [Apply->Close->finish]

under Connectivity Options setting.
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# Ethernet Download Settaings &l

Target device boot name:

IP address:  0.0.0.0
Boot loader: 0.0

Active barget devices;

AM1805-65535

TFTP block. size in bytes:

|512 Restare

[0]:4 Cancel |

Figure 4-7
10) Now go to [Target] -> [Attach Device] in VS2005 menu and click on Start to download “NK.bin”.
A dialog will pop up to indicate the download progress, once the download process completed
the serial terminal would display the below message:
OEMWriteFlash: NK written
ROMHDR at Address 80000044h
Image Start .......: 0x80000000
Image Size ........: 0x00ff9a74
Image Launch Addr .: 0x80001000
Image ROMHDR ......: OxcOff7be0
Boot Device/Type ..: 2/ 6
Got EDBG_CMD_JUMPIMG
Got EDBG_CMD_CONFIG, flags:0x00000000
BLFlashDownload: LogicalLoc - 0x62000000
Load NK image from flash memory (NAND)
FMD: ReadID (Mfg=0x2c, Dev=0xda)

BLFlashDownload: cpl
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11) Now power OFF the board and power ON and press the space key to enter into the EBOOT

menu. Form EBOOT menu press key [2]->[2]->[3] step by step to select NK from NAND flash,

and press [0] -> [0] to start the system from NAND flash.

4.6 User Instructions

4.6.1 How to use Power Management

1) This BSP release implements support for some basic power management states and system
suspend / resume. There is no support for voltage or frequency scaling.

2) Power Management Configuration
The sample PM configuration is enabled by default in platform.reg. The configuration can be
disabled by setting the BSP_POWERMAN variable in:
[...\<BSPFolder>\OMAPL138_AM18X.bat].

Notes:

1) When the sample PM configuration is disabled the default CE 6.0 PM configuration is used.

2) When entering the suspend state the CE Power Manager powers down all the peripherals
(sets all drivers to D4 state).

3) On L138/AM18x the SDRAM is put into self-refresh mode and powered down, the PLL
controllers are powered down and the SOC is put into Deep Sleep mode.

4) On L138/AM18x there are two wake sources supported:
* Internal source — RTC alarm
 External source via the DEEPSLEEP pin — connected to UART2 CTS

5) The “pmsuspend”tool can be used to enter the system suspend state. The wake source can
be specified on the command line.

6) On L138/AM18x when resuming the SDRAM and PLL controllers are powered up.

7) Onresume the CE Power Manager powers up all the peripherals (sets all drivers to DO state).
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Power Management Tools

When power management is enabled a number of tools are available:
® pmtimeout — Sets the idle timeouts used for transition between PM states
® pmsuspend — Sets an RTC alarm and puts the platform into suspend
® pmset — Sets the system power state
® pmget — Gets the current system power state
® pmsetd — Sets the power state for a device
® pmgetd — Gets the power state for a device
® pmreq — Sets a device power requirement
® pmmon — Monitors and reports on power state changes
Most of the tools display help if run without command line parameters. Some example usage as
follows.
e.g. Go into suspend with a 1 min RTC alarm:

CE device->Start->CMD prompt->pmsuspend -t 1

4.6.2 How to use CAMS8000-A module

1) Select [Third Party->BSP->OMAPL138_AM18x: ARMV4I->Device Drivers->Camera->VPIF
Capture Driver] from the VS2005 catalog menu.
2) Make sure that “DirectShow” items are selected in catalog items view, as shown in below

picture:
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=3 ESP
—|-{_J Core OS5
=|-{_1 CEBASE
-] Applications - End User
I Applications and Serwices Dewelopment
J Communication Services and Networking
I Core 0Z Serwvices
_J Device Management
i File Sy=stems and Data Store
] Fonts=
] Graphics and Multimedia Technologies
- ] Audie
+/-{_1J Graphics
=-{_J Media
+-{_J Audio Codecs and Renderers
+-{_J Digital Rights Management
—-{_J DirectShow
|E| BCR Wrapper Filter
+ |E| DirectShow Core
Iil DirectShow Display
DirectShow Error Messages
DirectShow Video Capture
Iil DMO Wrapper Filter

T R B R

Figure 4-8
3) Click [Build-> Rebuild Solution] in VS2005 to perform “sysgen” and build BSP.
4) Update “NK.bin” and “NK.nb0Q” after sysgen and build BSP completed.
5) Confirm CAM8000-A module is connect to SBC8018 correctly, boot system with updated NK,
copy [C:\WINCEG600\PLATFORM\SBC8018\files\CameraDshowApp_analog.exe] to run
Windows CE OS on the kit and click “CameraDshowApp_analog.exe” to view camera

preview.

The VPIF driver support PAL(720*576) and NTSC (720*480) camera, and
the drivers is default set to support the PAL camera, some parameter in
VPIF drivers should be change with NTSC camera, if you want to view the

whole of picture in LCD, please use 7inch LCD connect to SBC8018.

4.7 SBC8018 Windows CE 6.0 win32 API application

development Demo

For SBC8018 Windows CE 6.0 win32 API development demo please refer to

[bsp\OMAPL138_AM18X\SRC\TEST\APPS].
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Appendix

Appendix I: Hardware Dimensions
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Figure Appendix 1-1 Hardware Dimensions Diagram
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Appendix II: The Installation Of Ubuntu

How to install Ubuntu in Windows environment using VirtualBox.

The screenshots in this tutorial use Ubuntu 11.04, but the same principles also applies to Ubuntu
10.10, 11.04, and any future version of Ubuntu. Actually, you can install pretty much any Linux

distribution this way.

VirtualBox allows you to run an entire operating system inside another operating system. Please
be aware that you should have a minimum of 512 MB of RAM. For better performance 1 GB of

RAM or more is recommended.

Installation Process

1. Download software

Before installing Ubuntu, you must get VirtualBox software and Ubuntu disk image (ISO file). Both

can be downloaded from VirtualBox download page (VirtualBox-4.0.10-72479-Win.exe) and _

Ubuntu download page (ubuntu-11.04-desktop-i386.is0).

2. Create New Virtual machine

¥ Create New Virtual Nachine

Welcome to the New Virtual Machine Wizard! Toss

This wizard will guide you through the steps that are necessary to create a #/—
Box. § !

new virtual machine for VirtualBox

Use the Hext button to go to the next page of the wizard and the Back P
button to return to the previous page. You can also press Cancel if you
want to cancel the execution of this wizard.

Figure Appendix 2-1
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After you launch VirtualBox from the Windows Start menu, click on New to create a new virtual

machine. When the New Virtual Machine Wizard appears, click Next.

‘f‘ Create New ¥irtual Nachine

VM Name and 0S5 Type

Enter a name for the mew wirtual machine and select the type of the guest
operating system wou plan to install ontoe the wirtual machine.

The name of the wirtual machine usually indicates its software and hardware
configaration. It will be nsed by all VirtualBox components to identify
wour wirtual machine.

Hame

Tbuntu |

05 Type

Operating System: |Linux V| ‘%
]

Yerszion: |U'buntu

[z |2 [ cmea

Figure Appendix 2-2

You can name the machine whatever you want to name it, we are installing Ubuntu so it makes

sense to name it as Ubuntu. Otherwise you can name it as what you like:

‘f‘ Create New ¥irtual Nachine

Memory

Select the amount of base memory (RAM) in megabytes to be allocated to the
virtunal machine.

The recommended baze memory size iz 912 MB.

Baze Memory Size

4 ME 2048 ME
’ < Back ] I Hext » l ’ Cancel

Figure Appendix 2-3

VirtualBox will try to guess how much of your memory (or RAM) to allocate for the virtual machine.
If you have 1 GB or less of RAM, | would advise you stick with the recommendation. If, however,
you have over 1 GB, about a quarter of RAM or less should be fine. For example, if you have 2 GB
of RAM, 512 MB is fine to allocate. If you have 4 GB of RAM, 1 GB is fine to allocate. If you have
no idea what RAM is or how much of it you have, just go with the default.
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Click Next.

?' Create New Yirtual Nachine

Virtual Hard Disk

Select a wirtual hard disk to be used az the boot hard dizk of the wirtual
machine. You can either create a new hard disk or select an existing one
from the drop-down list or by pressing corresponding button (to inwvoke
file-open window).

If you need a more complicated hard disk setup, wou can also skip this step
and attach hard disks later using the WM Settings dialeg.
The recommended size of the boot hard disk iz &.00 GB.

Eoot Hard Disk

reate new hard dis

O Use existing hard disk

|'U'buntu. vdi (Normsl, £.00 GE)

’ < Back H Hext > H Cancel ]

Figure Appendix 2-4

If this is your first time using VirtualBox (which it probably is if you need a tutorial on how to use it),

then you do want to create new hard disk and then click Next.

?‘ Create New ¥irtual Disk |E|r5__<|

Welcome to the Create New Virtual Disk Wizard!

Thiz wizard will help wou to create a mew wirtual hard disk for your
wirtual machine.

Use the Wext button to go to the next page of the wizard and the Back
button to return to the previous page. You can also press Cancel if you
want to cancel the execution of thiz wizard

< Back [ Hext > | ’ Cancel

Figure Appendix 2-5

Click Next again.
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¥ Create New Virtual Disk

Hard Disk Storage Type

Select the type of wirtual hard disk you want to create.

& dynamically expanding storage initially occupies a wery =mall amount
of space on your physical hard disk It will grow dynamically fup to the
zize specified) as the Guest 05 claims disk space.

& fized-size storage does not grow. It iz stored in a file of
approximately the same size as the size of the wirtual hard disk The
creation of a fixed-size storage may take a long time depending on the
storage size and the write performance of your harddisk.

Storage Type

() Dynamically expanding storage

’ < Back ] I Hext > l ’ Cancel

Figure Appendix 2-6
Select Fixed-size storage and click Next again.

%) Create New Virtual Disk

?IX
Virtual Disk Location and Size
Press the Select button to select the location of a file to store the hard

dizk data or type a file name in the entry field

Location

F:\UbuntutUbuntu. wdi| | @

Select the size of the wirtual hard disk in megabytes. This zize will be
reported to the Guest 0S5 as the maximum size of this hard disk

Size

-
J 8.00 6B

4.00 ME 2.00 TE

’ < Back ][ Hext > l’ Cancel

Figure Appendix 2-7

Ubuntu's default installation is less than 8 GB. If you plan on adding software or downloading large

files in your virtualized Ubuntu, you should select more space accordingly.
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¥ Create New Virtual Disk |E”z|

Summar y

Tou are going to create a mew wirtual hard disk with the following
parameters:

Type: Fixed-size storage
Location: G:\Ubuntu system‘Ubuntu. wdi
Size: 3.00 GE (8539934592 B)

If the above settings are correct, press the Finish button Once you press
it, a new hard disk will be created.

[ < Back H Finish ” Cancel

Figure Appendix 2-8

acle YE VirtualBox Nanager

File Machine Help
{:a .E 3 v |{€} Details | (@) Snapshets
Hew a
T Create New ¥irtual Disk [
Summary
You are going to create = new virtual herd disk with the following
parameters:
: Creating fized medium storage unit °G:\lUbuntu system\Ubuntu. .. A
Cresting fixed medium storage unit *G:'Ubuntu system\Ubuntu, wdi’
M ] = X
1 minute, 56 seconds remaining
.rhel-
o kudis
Host Driver: Windows DireciSeund
Contreller: ICH ACST 2

Figure Appendix 2-9

Click Finish and wait for the virtual hard drive to be created. This is actually just a very large file

that lives inside of your Windows installation.
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57 Create New Virtual Disk (6&\

Summary

You are going to create a new wirtual hard disk with the following
parameters:

Type: Fixed-size storage
Location: G:\Ubuntu systea\Ubuntu vdi
Size: 8.00 GB (8589934592 B)

If the above settings are correct, press the Finish button Once you press
it, & new hard disk will be created

[ <Bak |[ Eimish ][ Conca |

Figure Appendix 2-10

Click Finish. The virtual hard drive is successfully created.
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3. Installing Ubuntu

Y Oracle VE VirtualBox Hanager

File Machige lilp
# Ubuntu — Settings
& s
Hew I General ‘
= System -~
Displey Basic | Advanced | Description
@ Storage Hane: [Ubuntu | |
P dudio Operating Systan: |Linux v/ "
(]
& Hetvork Version: [Vbuntu v
9 Serial Ports
& usp 7
Shared Folders
~
Select a settings category from the list on the left-hand side and move the
mouse over a settings stem to get more fnformation.
[ o ][ canca |[ Hp |
= |

Figure Appendix 2-11

"_\ Oracle VM VirtualBox Manager

— -
i’ ‘;’ = General | Storage A
& System
- St Ti Attribut
Displey Storage Tree es
@ Storsge Choose a virtual CD/DYD disk file &3]
o Audo Look in: |@sonware _VJ = e B3~
& Nework (,2 [Buburtu-11 04-deskiop-i385 =
9 Seiial Ports
My Recent
ﬁ Use Documents
Shared Folders @
Desktop
]
| My Documents
My Computer
‘A N
My Network =
Places File name: I| j Open e
Files of type: |l CDDVD-ROM disk images (*.dmg *iso *.cd v | Cancel

Figure Appendix 2-12

Before Installing Ubuntu in a virtual machine, the first thing to make the (currently blank) virtual
hard drive useful is to add the downloaded Ubuntu disk image (the .iso) boot on your virtual
machine. For that, click on Settings and Storage, then under CD/DVD Device select the

Ubuntu .iso you downloaded earlier.
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£ Ubuntu - Settings

General

= Storage
@ System
Display Storage Tree Attributes
® Storege @ IDE Controller CD/DVD Drive: |IDE Primary Master v @
P Audo (2 ubuntu-11.04-desktop-i386.iso Information
&P Network @ SATA Controller Typs:Image
— Size: 685.29MB
. ) Ubuntu.vdi
¢ Serial Ports - Lacation:  D:\softwareubuntu-11.04-desktol
ﬂ Use D:Asystem\Ubuntu.vdi Sy
Type (Format): MNormal [¥DI)
[ Shared Folders Attached to: Ubuntu

@@

Contains all storage controllers for this machine and the virtual images and host drives attached to
them.

4\ Norvoptimal settings detected [ ok |[ cancel J[ Heb |

Figure Appendix 2-13
Once you've selected it, click OK.

Then double-click your virtual machine to start it up.

¥irtualBox — Information

You have the Auto capture keyboard option turned on. This will
cause the Virtual Machine to automatically capture the keyboard
every time the VM window is activated and make it unavailable to
other applications running on your host machine: when the keyboard
is captured, all keystrokes (including system ones like Alt-Tab)
will be directed to the VM.

You can press the host key at any time to uncapture the keyboard
and mouse (if it is captured) and return them to normal operation.
The currently assigned host key is shown on the status bar at the

bottom of the Virtual Machine window, next to the icon. This
icon, together with the mouse icon placed nearby, indicate the
current keyboard and mouse capture state.

The host key is cwrrently defined as Right Ctrl.

DEDO not show this message again§

1< >

SBOLP [#]Right Ctrl

Figure Appendix 2-14
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¥irtualBox — Information

The wirtual machine window is optimized to work in 32 bit
color mode but the wirtual display is currently set to
16 bit.

Please open the display properties dialog of the guest 0S
and select a 32 bit color mode, if it is available, for
best possible performance of the wirtual wideo subsystem.

Hote. Some operating systems, like 05/2, may actually
work in 32 bit mode but report it as 24 bit (16 million
colors). You may try to select a different color mode to
see if this message disappears or you can simply disable
the message now if you are sure the required color mode
(32 bit) is not available in the guest 0S.

[]iDo not show this message again:

| SIQy A ImEn: [#]Right Ctrl

Figure Appendix 2-15
Click OK

i

|

I

1

i

I

|

Ubuntu 11.04

| BOL & )0 G Blrien co1

Figure Appendix 2-16
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.

LHE

Welcome

Asturiary

Bahasa indonesia d

Bosanski

Catala

Ceilina

Dansk

Deutsch

Eest

——

Esparal
Esperanto
Luskara Try Ubuntu Install Ubuntu

Frangais

Gaellge You can try Ubuntu withaut making any changes ta yaur computer, directly
Galego from this CD.
Hrvatski

eCnt: Or IF you're ready, you can install Ubunty alongside (or instead of ) your
Islenska current operating system. This shouldrit take too long
Italiaro

Kurdi :
Youmay wish Lo read Lhe rel=ss

Figure Appendix 2-17

Select language and click Install Ubuntu.

Install

Preparing to install Ubuntu

For best results, please ensure that this computer:

has at least 4.4 GB available drive space

o
o Ispluoged into a power saurce
¥ is connected to the internet

_ Download updates while installing

Ubuntu uses third-party software to display Flash, MP3 and other media, and to work with some wireless
hardware, Some of Lhis software is closed-source, The software is subject to the license terms included
with the software's documentation,

Install this third-party software
Fluerda MP3 plugn Includes MPEG Layer-3 audo cecodrg techralogy licensed from Fraunhofar 15 and Thomsen

Quit Back Forward 5 |

Figure Appendix 2-18

Click Forward.
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? Install

Allocate drive space

This computer currently has no detected operating systems.
what would you like to do?

Erase disk and install Ubuntu
O] Warning:
* Something else

Quit Back Forward

Figure Appendix 2-19

Click Forward.

™ Install

Erase disk and install Ubuntu

Select drive: | SCSI3 (0,0,0) (sda) - 8.6 GB ATA VBOX HARDDISK =

®

Ubuntu
[dev/sda (extd)

8.6 GB

The entire disk will be used:

Quit Back Install Now

Figure Appendix 2-20

This is the no-turning-back point. If you decide to do this, your hard drive will be repartitioned and
part or all of it will be formatted. Before you click this button “Install Now” to continue, make sure

you have everything backed up.
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Install

Where are you?

Gannames o

New York

Figure Appendix 2-21
While Ubuntu is preparing files to copy over for installation, it'll ask you some questions. They're

self-explanatory.

Inskall

keyboard layout

Chogse your keyboard layouk:
Tajikislan LISA,
Tanzania u5a - Alternative inkernational
Thailard Usa - Cherokes
Turkey UEA - Classic Dvorak
Tuwkmenistan Wsa - Colemak
s - Dvorak
Ukraine USA - Dvorak alternative interrational (no dead keys
United Kingdam USA - Dvorak international (with dead keys)
Uzbekistan USA - International (AIEGT dead keys)
Vietnam USA - International fwith dead kews)
|Z' e fere Lo Desk ol keyhoard |
Betecl Keyboard Layoul
Fack H*

Figure Appendix 2-22
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Install

Who are you?

Your name: |Susan Brownmiller

Your computer's name: |ubuntudaplop

The rame it uses when it taks ta ather computers
Pick a isername: |susan
Choose apassword. 99000000000
Confirm your password: 0000000000
@ Loginautomalically
Require my password to login

Encrypt my home folder

Back | Forwar&

P Almost finished copying fles

Figure Appendix 2-23

Install

Welcome to Ubuntu 11.04

Ubuntu is packed with Features to make your
computer delightful to use. This version
introduces the Unity desktop interface; a
brand new way to find and manage your
applications, We'd like to show some cool
things to look for in your new operating
system.

» Almost finished copying files..,

Figure Appendix 2-24
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Find even more software

Install

The Ubuntu Software Centre has
thousands of new applications ready far

your computer. Just type what you waek Lo Lmessamame o pestant  saelzony |
or expiore the categories like games,
szience, ard educstion. It = simple to "N ctellari B ot e e«
' um ¥ A
downoad new stull and write revews to Pamitiln % n; :fmw
NS YOUr PXPErIErCes A
ter
( Sorme of our Favourites

05 30 photareal gic dhies i
i ieln n 3 eady she
WY, O CAN T A e, B
e o5l e

samclotse

+ el 1230005 11 00 Lhe HEERICES
Gl e At ene o o) 1l for (e

AL ane

+ PRRSCIn TeN B, AR A fraeetal 3800
e b e s B 1 Debes (00e

Figure Appendix 2-25

Installation Complete

Installation has finished. You can continue testing
Ubuntu now, but until you restart the computer, any
changes you make or documents you save will not be

preserved.

Continue Testing

Figure Appendix 2-26

The installation will finish (the whole thing can take anywhere between 15 minutes and an hour,

depending on the speed of your computer).
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Q Ubuntu - Settings

= General ‘ Storage ‘
System
Display Storage Tree Attributes
Storage @ IDE Controller CD/DVD Drive: |IDE Primary Master v|
P Audio : ® Empty Information
@ Network & SATA Controller Type: =
i T Size: -
3 Serial Ports & Ubuntuvd Location: -
£ Use Attached To: -

Shared Folders

@e@@e

On the System page, you have assigned more than 50% of your computer's memory (959.00 MB)
to the virtual machine, There might not be enough memory left for your host operating system. Continue
at your own risk.

_ﬁ Non-optimal settings detected l OK ][ Cancel ][ Help J

Figure Appendix 2-27
Afterwards, in order to use your virtualized installation (instead of continually booting from the live

CD), you have to change the CD/DVD Device entry to be Empty again.
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Appendix III: Driver Installation for Linux USB

Ethernet/RNDIS Gadget

1. If you haven'’t install the driver for Linux USB Ethernet/RNDIS Gadget, when you connect the
device, PC will find the new hardware and pops up a window on the screen, please select “From

list or designated location”, then click “Next”

Found Mew Hardware Wizard

Welcome to the Found New
Hardware Wizard

Thiz wizard helpz you install zoftware for:

RHDIS /Ethemet Gadget

Zi'jl If your hardware came with an installation CD
“2E& or floppy dizk. inzert it now.

What do you want the wizard to do”?

(3 Install the software automatically [Fecommended)

{#3install from a list or speciiic lacabon [Advanced)

Click Mexst to continue.

[ MHest » ][ Cancel

Figure Appedix 3-1
2. Designate a path for the USB driver, and the USB driver directory is [disk\linux\tools], then click

“Next”
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Found Mew Hardware Wizard

Pleaze choose your search and installation options.

() Search for the best driver in these locations.,

Ilze the check boxes belaw to limit or expand the default sgarch, which includez local
pathz and removable media. The best driver found will be installed.

[¥]i5earch removable media [foppy, CO-ROM...E

Include this location in the search:

|E:'xDDc:uments and SettingzwwarkhDesktopiush driv v| [ Browse

() Dan't gearch, | will chooze the driver to install,

Choosze thiz option to zelect the device driver from a list. Windows does not guarantee that
the driver you choose will be the best match for your hardware.

[ < Back ” MHest » ][ Cancel

Figure Appendix 3-2

3. When the following appears, select “Continue”

Hardware Installation

] E The zoftware pou are installing for this hardware:
L]
Linus USE Ethernet/AMDIS Gadget

has not pazsed Windows Logao testing to werify itz compatibility
with "Windows *P. [T el me why this testing iz important. |

Continuing your installation of this software may impair
or destabilize the commect operation of your syztem
either immediately or in the future. Microsoft strongly
recommends that you stop this installation now and
contact the hardware vendor for zoftware that has
pazzed Windowsz Logo testing.

E-Enntinue Aryway | [ STOP Inztallation

Figure Appendix 3-3
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4. Please wait until the installation is completed

Found Mew Hardware Wizard
Completing the Found New
Hardware Wizard

The wizard haz finizhed instaling the zoftware faor:

Linus USE Ethemet/RMDIS Gadget

Click Finish to cloze the wizard.

Finizh

Figure Appendix 3-4
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Appendix IV: The Setup Of TFTP Server

1. Install client

$>sudo apt-get install tftp-hpa
$>sudo apt-get install tftpd-hpa

2. Install inet

$>sudo apt-get install xinetd
$>sudo apt-get install netkit-inetd

3. Configure the server
First, create “tftpboot” under root directory, and set the properties as “a random user can write and

read”

$>cd /
$>sudo mkdir tftpboot
$>sudo chmod 777 tftpboot

Secondly, add in /etc/inetd.conf:

$>sudo vi /etc/inetd.conf /[copy the follow word to this file
tftpd dgram udp wait root /usr/sbin/in.tftpd /usr/sbin/in.tftpd -s /tftpboot

Then, reload inetd process:

$>sudo /etc/init.d/inetd reload

Finally, enter directory /etc/xinetd.d/, and create a new file TFTP and put the designated content

into the TFTP file:

$>cd /etc/xinetd.d/
$>sudo touch tftp
$>sudo vi tftp
service tftp

Illlcopy the follow word to tftp file

{
disable = no
socket_type = dgram
protocol =udp
wait =yes
user = root
server = Jusr/sbin/in.tftpd
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server_args = -s /tftpboot -c
per_source =11
cps =100 2

4. Reboot the server:

$>sudo /etc/init.d/xinetd restart
$>sudo in.tftpd -l /tftpboot

5. Test the server

Conduct a test; create a file under folder /tftpboot

$>touch abc

Enter into another folder

$>tftp 192.168.1.15 (192.168.1.15was the server IP)
$>tftp> get abc

That download can be made means the server has been installed.
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Customer Service & Technical support

Customer Service

Please contact Premier Farnell local sales and customer services staffs for the help.

Website: http://www.farnell.com/

Technical Support

Please contact Premier Farnell local technical support team for any technical issues through the
telephone, live chat & mail, or post your questions on the below micro site, we will reply to you as
soon as possible.

Centralized technical support mail box: knode _tech@element14.com

Community: http://www.elementl4.com/community/docs/DOC-41892

Notes

This board was designed by element14’s design partner- Embest, you can contact them to get the
technical support as well.

Marketing Department:

Tel: +86-755-25635656 / 25636285

Fax: +86-755-25616057

E-mail: market@embedinfo.com

Technical Support:
Tel: +86-755-25503401

E-mail: support@embedinfo.com

URL: http://www.armkits.com
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